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Overview

The Development Services Department’s (DSD) online permitting system is a full cloud-based application that
allows customers to apply for permits online and upload plans and documents for review 24/7.

Before you begin, please review the information about the permit submittal requirements at
sandiego.gov/dsd.

When new permit applications are received, DSD will review the documents for completeness, assess
required fees, and assign the project to a reviewer.

o For help with user accounts or uploading documents, please call us at 619-446-5000.
o For plan requirements and document issues, please click here.
o For help planning you project, consider booking a virtual counter appointment with DSD.



http://sandiego.gov/dsd
https://www.sandiego.gov/sites/default/files/dsd-document-requirements.pdf
https://www.sandiego.gov/development-services/virtual-appointments
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e Log into your online
permitting account.
e Enter your username and eass Login Login

Many online services offered by the Agency require login for security reasons. If you are an existing user. please enter

m Development Permits Code Enforcement  Short Term Rental

pa SSWO rd . * your user name and password in the box on the right. Usar Mane or E-msik
New Users
1 If you are a new user you may register for a free Citizen Access account. It only takes a few simple steps and youTl Password:
have the added benefits of seeing 3 complete history of applications, access to invoices and receipts, checking on the
* If yo u a re a neW user see th e status of pending activities. and more.
’
tutorial on how to register for
Remernber me on this computer
an account. I've forgotten my password

New Users: Register for an Account

e Select “Development Permits”

Homel| JRETEETGELEEGIICE [Code Enforcement  Short Term Rental

e Apply for a Permit Q search for a Permit Application

e Select “Apply for a Permit”
Home QJRETEGWGENEEGIEE Code Enforcement  Short Term Rental

i Apply for a Permit Q search for a Permit Application

e Read and acknowledge the General Disclaimer -

disclaimer This website is intended for convenience and informational purposes only.
e Click “Continue Application” _ _ o _ ) _
While we strive to ensure the accuracy. timeliness, and function of this website, the
City of 5an Diego makes no representations or warranties regarding its content,
condition, sustained performance, resistance and immunity to computer viruses or
4 malware, or proprietary infringement.

| have read and accepted the above terms.

Continue Application


https://aca-prod.accela.com/SANDIEGO/Dashboard.aspx?TabName=Home
https://aca-prod.accela.com/SANDIEGO/Dashboard.aspx?TabName=Home
https://www.sandiego.gov/sites/default/files/final_opendsd_2.0_tutorial_01.12.18.pdf
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Select a Record Type
e Select a permit type from “Informational Applications,” then click “Continue Application”

Note: For PTS Permits, please refer to instructions in the OpenDSD User Guide to PTS Projects.

Select a Record Type

» PTS

» Building Applications (O PTS Electronic Submittal

(O Building Construction
(O Building Construction - CIP or Public Project > Grading. Right of Way, Mapping Applications
g E!Lyldmg Construction - Master Plan Accessory O Deferred As Graded
ructure .
O Engineering - Mapping
(O Building Construction - Master Plan MDU O Engineering Consiruction Change

(O Building Construction - Master Plan SDU - )
Grading, ROW, M -A ted Submittal ?

(O Building Construction - Master Plan Small Cell Telecom 8 Riraht”:)?lWa 7‘D azilllntﬁas ssotialed submita O

(O Building Construction - Special Programs @ 10 i ,

) Deferred Fire Submittal O Right of Way - Minor - Rapid Review

(O Deferred Submittal P Traffic & Transportation

() Demolition O Construction Noise Permit
QO Fire O Traffic Control Permit
(O Plan - Mechanical/Electrical/Plumbing Standalone O Transportation Permit
O Sign
» Discretionary Applications
» Construction Change O Discretionary Project
(O Building Construction Change
O Fire Construction Change » Informat_ionalApp_lications
@ Preliminary Review
» Photovoltaic (O Zone History Letter
O Photovoltaic
(O Photo-voltaic Residential Project » Historic Applications )
O Individual Historical Resource Nomination
» Simple No Plan Permits O Mills Act Agreement
(O No-Plan - Nonresidential/Multifamily - Electrical
(O No-Plan - Nonresidential/Multifamily - Mechanical ¥ Miscellaneous Applications .
(O No-Plan - Nonresidential/Multifamily - Plumbing O Others . 2
O No-Plan - Residential - Combination Mech/Elec/Plum O Street -Tree Permit
» Project Contacts
(O Add/Remove Licensed Contractor @)
Continue Application
1. Indicate if there is an address
. . » Informational Applications
for the PrOJeCt Site @ Preliminary Review
2. Click “Continue Application” O Zone History Letter

Address Validation

*1. Is the project site located within the public right-of-way, within
a public easement, or is it a unique situation or general question O Yes @ No
that is not tied to a specific address or parcel?:

Continue Application


https://www.sandiego.gov/sites/default/files/opendsd-user-guide-pts-projects.pdf
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Address or Parcel Entry

e Enter Street No. and Street
name only (the system will
populate the parcel info)

e Click “Search”

OR

e Enter parcel number in
#H##-#H44-#4#44# format (the
system will populate the
address info if it exists)

e Click “Search”

Apply for a Preliminary Review

Tip: For numeric Street Names in single digits, add a zero (0). For example, for 1st Av use (

*Street No.: Direction:  *Street Name: Street Type:

1222 --Selectr 01st v -

* Parcel Number:

Legal Description:
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Preliminary Specific Information

e Enter the scope of work for your project

¢ Indicate the proposed use for the project

e Select whether you are requesting a single or multiple discipline preliminary review
o Select the specific discipline(s) that are applicable to the review(s) you need

PRELIMINARY SPECIFIC INFO

Preliminary Review Information

* Scope of Work: Reguirements for
building an ADIL

* Select the proposed Use:

Single Dwelling -

* Select the Type of Preliminary Review:

Single Discipline Prelimire

DISCIPLINE LIST

DSD-Combined: @0
DSD-Dowmtown: @0
DSD-Drainage and Grades: @ (]
DSD-Electrical: @0
DSD-Enginesring: @0
DSD-Environmental: @ (]
DSD-Fire Alarm: @0
DSD-Fire Suppression: @ (]
DSD-Geology: @ (]
DSD-HazMat: @0
DSD-Historic: @
DSD-Landscape: @0
DSD-Map Check: @0
DSD-Mechanical: @O
DSD-Noise: @ (]}
DSD-Planning Review: @ ]
DSD-Smoke Control: @0
DSD-Strustural: @0
DSD-Telecom WCF Review: @0
DSD-Traffic Safety: @0
DSO-Transportation Development: @ O
DSD-Water and Sewer: @0
Fire-Plan Review: @0
Planning-Facilities Financing: @ (]
Planning-Long Range Planning: @ (]
Planning-MSCP: [©]w]
Planning-Park and Recreation: @ O

Continue Application

. RETURN TO TOP
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Required Documents

e Using the “Choose File"” button, search for and upload the Preliminary Review Questionnaire (DS-
375)

*indicates a required field.
Required Documents

The maximum file size allowed is 200 MB.

* Required Documents

1. Required Attachment - Preliminary Review Questionaire Choose File | No file chosen

Additional Documents
Upload additional documents you wish to include with your submittal

e Click "Add”

1 0 The maximum file size allowed is 200 MB.

File Name File Size Type

Preliminary Review Questionnaire.pdf 39.71 kB Preliminary Review Questionaire

e Click the “Choose File” button
and search your files to attach New Attachment

them Choaose File | Na file chasen

e Click Type drop-down and select

file type Type

e Provide a brief description of —Select-- “
the document

e Click the “Submit” button Description

e Click “Continue Application”
11

4

o [ R

Continue Application

. RETURN TO TOP


https://www.sandiego.gov/sites/default/files/ds375.pdf
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Review Application

Review the Application and
return to previous steps by
clicking on the numbered
tabs at the top.

e Acknowledge the final
certification
e Click “Continue Application”

Apply for a Preliminary Review

Rev. 6/02/2023

1 fade 2 fmew o & Documens 4 Foviow S Schmitnd

Continue Application

Click o i - b e e

Record Type

PRELIMINARY SPECIFIC INFO

s mow s =
Scapa i W Mo D

ol thepropes Usa: Sewia Dwling

ol tha Ty o ratemncry vk Sigla Discping rsteinzey Roview

4
FEFEEFEFFEFFEFEFFEFEEFEEEEG

certify that | have read this applcation and state the abowe inform:
entitlement to the use of the propery that is the subject of this appli
policies and regulations applicable fo the proposed development or
laws or regulations, including before or during final inspections. City

regulation, nor does it constitute a waiver by the City to pursue any

the city to enter the above-identified property for inspection purpose

checking this box, | agree to the abowe certification.

Continue Application
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Your record number will be
created and displayed

e Click the “View Record
Details” button to review
the project information
and documents you
submitted, and see what
payments have been made
or need to be paid.

14

A confirmation and further
instructions for payment will be
sent to your email address.

Review will not begin until all fees
are paid.

View Record Details

To view project information from
your home screen:

e Select the “Development
15 Permits” tab

Your records will display with the
current statuses.

e Click on the blue PR} link of
the Preliminary Review

Apply for a Preliminary Review

Rev. 6/02/2023

Step 5 : Submitted

Your application has been successfully submitted.
Please print your record and retain a copy for your records.

Thank you for using our online services.
‘Your Record Number is PRJ-8007048.

You will need this number to check the status of your application or to schedule/check results of
fees have been assessed or permit issuance has been processed.

Choose "View Record Details” to Schedule Inspections, check status, or make other updates.

View Record Details » B

[EXTERNAL] New Submittal — PRJ-8007048

noreply@sandiego.gov
To ® Thomas, J.C.

Retention Policy 5 Year Retention (Inbox) (5 years)

DSD_007_Invoice_202203_NEW_20230530_132525.pdf 68 KB

Hello,

Development Services has created your application.
Record ID: PRJ-8007048

Record Address: 1222 01st Av, San Diego, CA
Record Type:

Please do not reply to this email, this mailbox is not monitored.
Your Preliminary Review application has been received by the Development Services Department

For a Single Preliminary Review:

Please proceed to pay the attached invoice, to place your project into review status.

For a Multiple Preliminary Review:

During the prescreening process, staff will evaluate the submittal package to ensure the required ir

Hom. Development Permits ode Enforcement  Short Term Rental

o Apply for a Permit Q search for a Permit Application

Records ~Select

Fo sort the table below, click the column name to perform an alphabetical sort on that column. For example, click “Application Name” (o sort records by Application Name in ascending order (A-Z). and ¢/
‘0501t in descending order Z-A)
Showing 61-70 of 100+ | Download resuts | Add w collecsion

L Date HRecord Number Record Type ‘Application Name Description Status.

- Approval - Construction - Fire Pmt  Approwal - Construction - Fire Pmt
[0 ouroa PMT-8001493 ek s ety Opened

D e =

Standard-Fire:4250/05th Issued
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Your project information will load and you will be on the Record Info tab.

e To see document attachments for the project, click the Attachments tab

LELEE Development Permi Building & Land Use Enforcement  Short Term Rental

+ Apply for a Permit Q Search for a Permit Application

Record PRJ-8007048: Add
Preliminary Review
Record Status: Application Pending Payment

fecordnfo Paments

IMPORTANT: Al the requested documents must be uploaded at the same time. Incomplete submittals will result in review delays.
Follow the below steps to upload the requested documents:

Click on "Add Attachment”

Click on "Choose File" and add the document

Select the correct document type from the dropdown and click on "Submit’. For example, if the requested document is “Sign Plans” - select "Sign Plans® from the “Type” dropdown.
Once you click “Submit’, walt for the page to reload confirming the document upload. Please do not try to refresh the page during this process.

Repeat the above steps to upload all the requested documents. Once all the requested documents are uploaded, the "Add Attachment” will disappear automatically.

If the "Add Attachment" button doesn't disappear, that confirms that you have not submitted all the requested documents.

For review processing times, please check here for the latest Information.

1222015t Av*
NADBZ_EASTING: 6280745

NAD8Z_NORTHING: 1842268

LEFTRIGHT_CD: L

ADDRESS_PLACEMENT: Manual-Highly Confident
ADDRESS._LIFESPAN: Permanent

SOURCE_CD: S

DSD_ADDRESS._ID: 425564
SANGIS_ADDRESS_ID: 5256

ADDRESS_STATUS: Pending

Record Details

Applicant: Description: Owner:
Individual Preliminary Review:1222/01st - Single CITY OF SAN DIEGO *
JCTHOMAS Public Agency
1222 1ST AVENUE 00000

SAN DIEGO, CA, 92101
Home Phone: (619) 236-6552
Work Phone: (610) 236-6552
Mobile Phone: (619) 236-6552
JICTHOMAS@SANDIEGO.GOV

» More Details

Apply for a Preliminary Review

Rev. 6/02/2023



1 7 Repeat the above steps to upload all the req| . Once all the req| documents are uploaded, the "Add Attachment” will disappear automatically.
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e To view fees and payment information for the project, click the Payments tab

Home QOETEGCLELIE TSN Building & Land Use Enforcement  Short Term Rental

+ Apply for a Permit Q Search for a Permit Application

Record PRJ-8007048: Add to collection
Preliminary Review
Record Status: In Queue

N — -m

IMPORTANT: All the must be at the same time. Incomplete submittals will result in review delays.

Follow the below steps to upload the requested documents:

Click on "Add Attachment”

Click on “Choose File" and add the document

Select the correct document type from the dropdown and click on "Submit”. For example, if the requested document is “Sign Plans” - select "Sign Plans" from the "Type™ dropdown.
Once you click "Submit”, wait for the page to reload confirming the document upload. Please do not try to refresh the page during this process.

If the "Add Attachment” button doesn't disappear, that confirms that you have not all the
For review processing times, please check here for the latest information.

Attachments

To upload attachments:
1. Click Add to start the process

2. Click Add for each file to upload
The maximum file size allowed is 200 MB.

are disallowed file types to upload.

Attachments (2) Approved or Reviewer Issues (1)

File Name File Size Status Type Refresh
Photegraphic Survey PRI-8007048 230530132523.pdf 39.71 kB Uploaded Photographic Survey
Preliminary Review Questionaire PRI-8007048.pdf 39.71 kB Uploaded Preliminary Review Questionaire

On the Fees page, the breakdown for a single discipline review will look like the following:

Home QOETEGRTIGE SN (Tl Building & Land Use Enforcement  Short Term Rental

-

+ Apply for a Permit o‘ Search for a Permit Application

Listed below are the fees based upon the information you've entered. The following screen will display your total fees.

Fees
Fees oty Amount
Mapping 1 510,00
Prelim Rvw-Single 1 $1319.08
Records-Prelim(SDU) 1 $54.41

TOTAL FEES: $1,383.49
Note: This does not include additional inspection fees which may be assessed later.

10
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e To pay outstanding fees, click the link that say “Pay Fees.” Your review will not begin until the fees
for it are paid.

Home QDETERITIELIRLEN TN Building & Land Use Enforcement  Short Term Rental

* Apply for a Permit O Sooret e m Rmrtspalesie

Record PRJ-8007048: Add to collection
Preliminary Review
Record Status: Application Pending Payment

1 8 Record Info Payments Attachments.

IMPORTANT: All the requested documents must be uploaded at the same time. Incomplete submittals will result in review delays.

Follow the below steps to upload the requested documents:

Click on "Add Attachment"

Click on “Choose File’ and add the document

Select the correct document type from the dropdown and click on *Submit”. For example. if the requested document is “Sign Plans” - select *Sign Plans" from the "Type" dropdown
Once you click “Submit”, wait for the page to reload confirming the document upload. Please do not try to refresh the page during this process.

Repeat the above steps to upload all the req . Once all the req documents are uploaded, the "Add Attachment” will disappear automatically.
If the "Add Attachment” button doesn't disappear. that confirms that you have not all the req

For review times, pl heck here for the latest information.

Outstanding:
Date Invoice Number ‘Amount

05/30/2023 88032 55441 Pay Fees

05/30/2023 88032 51000

05/30/2023 88032 $1,319.08

Total outstanding fees: $1.383.49

Loading...

e Enter your bank details

Add New Bank Details

If you have a business or Corporate bank account that has ACH filter/block,
please contact your financial institution and add the following ACH
company IDs and names to the account before you complete this
transaction. Failure to do so may result in your payment being rejected and
the assessment of penalties and fees.

Name: DSD ACA Payment
ACH Company ID: 7956054878

Name: Alacriti (3rd Party Service Fee)
ACH Company ID: 2800853509

19

Name on Account: *

[ DSD

Account Type: * Personal or Commercial Account: *

[ Checking V] [ Commercial Bank Account

Routing Number: * What s this?

[ 055002707

Account Number: * Whatisthis? ~ Re-Enter Account Number: *

[ [ 5056792

Please re-enter your Bank Account Number.

11
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e Review and confirm your The City of
Preliminary Review SAN DlEGO’
payment
Thereis a third-party service fee per transaction of $1.50 flat fee for e-check, 2.95% fee for credit card payments, and 1.50% fee for debit card
payments.
Enter Payment Review Thank You
Almost Done
Please review your payment :
Account Details
Transaction ID: 1030322
Payment Details
Payment Method: Checking ending in 6792
Routing Number: 055002707
Payment Date: 05/30/2023
Payment Amount: $1,383.49
Third-Party Service Fee: $1.50
Total Amount: $1,384.99
Two Transactions will appear on your bank statement, one in the amount of [Payment Amount] and one in the amount of [Third-
Party Service Fee].
By clicking Confirm you authorize us to initiate a debit from the Payment Method Account to make a payment to the Account or
Invoice. The payment to your account will be made on the Payment Date detailed above, and the debit from your account will
occur within two business days of that date, but no earlier than that date. You also authorize your financial institution(and its
successors or assigns) to process this debit to your account.
edit | | cancal
L] Payment confirmation will [EXTERNAL] City of San Diego DSD ACA Payment Payment Scheduled Successfully
be sentto yO ur emal I City of San Diego DSD ACA Payment <donotreply@billerpayments.com>
To @ Thomas, J.C.
address.

Retention Policy 5 Year Retention (Inbox) (5 years)

**This email came from an external source. Be cautious about clicking on any links in this email or opening attachments.**

Dear Customer,

21

This email is to confirm a DSD ACA Payment transaction received on 05/30/2023 for the following:

Payment ID: 1030322

Web Reference ID: -N/A-

A one-time payment of $1,384.99 has been scheduled with a date of 05/30/2023. The funding source that will be debited for.
The confirmation number for this payment is INXHSXGP5SM.

We appreciate your business. If you have any questions, please contact our office.

Note the changing of the project's record status as it proceeds through DSD’s review process

Record PRJ-8007048: Record PRJ-8007048' Record PR3- 8007043 Record PRJ-soo7o4B-
I Record Status: In Review I - I Record Status: Reviews Complete I - I Record Status: Ready for Issuancel - I Record Status: Closed I
Record Info Record Info Payments. Record Info Payments Record Info

12
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Preliminary review comments will be provided in the formats below, depending on the type you choose.
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MULTI-DISCIPLINE REVIEW

Project Issues Report
PRJ-B006916

30 May 2023 4:36:22 PM
Pagelof2

s)

THE CITY OF SAN DIEGO
Development Services Department
1222 1st Avenue, San Diego, CA 92101

Project Address 1222 0lst
San Diego, CA
Project Type Preliminary Review
Instructions
Test
Preliminary Review Questionaire PRI-B008818 pdf
DSD

TrainingDBCS 1 DSD-Combined
TrainingDBCS 1@s andiege.gov

[Comment 00001 | Sheet GO1]

General

Preliminary Reviews are designed to respond to specific submitted questions regarding a potantial project and to
identify major Issues with the project. The absence of any information not addressed within the course of this
review should not be construed as approval of any aspect of your project. This Preliminary Review is nota
«comprehensive plan review, nor is it intended to replace the services provided by design professionals. A
complete review of the project will only be conducted when a complete set of plans is submitted as a part of the
formal application. (info Only]

Although itis the intent of this Preliminary Review to aid you in the development of your praject, it is ultimately the
applicant's responsibllity to ensure compliance with all applicable laws, governing policies, and regulations
including Information that may not have baen addressad in this review. (Info Only]

The applicantis responsible far knowing and understanding the governing policies and regulations applicable to
the proposed development, and the City is not liable far any damages or loss resulting from any actual or alleged
fallure to inform the appli fany laws or that may be applicable to proposed d [info
anly]

| Sheet 601] jectis subject to of school impact fees_ The City of San Disgo
determines the chargeable square footage and the fee amounts are calculated by and paid to the appropriate schaal
district(s). To calculate the fee, the school district(s) will need a City of San Diega Approval Report which documents the
chargeable square footage. This report may be printed from the computers in the customer self-help area at the

13

“The City of
SAN DIEGOJ

Develapment Services Department
Prolect Subimital & Management Diison

06-05-2023

Scott Robinson
1222 First Avenue
San Diege, California

Subject:  Preliminary Review Assessment Letter

Dear Mr. Robinson,

The D ices D
above, and desmhed as

has compileted the pi review request

= Multi-Preliminary review for an Accessory Dwelling Unit. The project includes the
construction of a new Accessory Dwelling Unit.

Enclosed is the Project Issues Report (Enclosure 1) which contains review comments based upen the
information provided and the specific questions asked in the Preliminary Review Questionnaire. The
purpose of this assessment letcer is to document staff responses o your specific questions and
identify a course of action for the processing of your request. If you plan t pursue this item, please
note that a project will require a1 of 3 project © ices for
a comprehensive plan review.

I ISSUES: The general issues based on your submittal are summarized below from the
meeting on May 4 2023. Resolution of these issues could affect your proposal. Additional
explanation is provided in the Project Issues Report.

PLANNING

+  The category uses per the planning reviewer has determined that ADU is a Permited
UserAllowed by Right.

1222 Frss avane, M Stason 201
on Diege, CAS2101- 4101
avah@andegag:

7 (6194465000

sandisgegor
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